
Photographs & Text for the Railway Observer –
Summer 2023 An updated guide to submitting images

for publication Version 05-3

PLEASE NOTE THERE ARE MAJOR CHANGES IN THIS
SUMMER 2023 LATEST EDITION OF THE GUIDELINES

THESE ARE HIGHLIGHTED IN RED

Introduction:-
This document provides guidance on the procedures for submitting photographs for possible
inclusion in the Railway Observer and any other RCTS publication. Collating, selecting and preparing
images for publication is a complex and time-consuming process applying these guidelines will help
to minimise the work.

On a number of occasions the RO Managing Editor has made it clear that we have probably reached
the peak of our processing capability in terms of what we can produce with our present resources
and the co-operation of photographers is required to reduce the workload for the Image Editors.
We now receive into the roimages@rcts.org.uk mailbox some 100+ emails every month with 150+
images submitted of which can result in approximately 60+ images being published each month.

Please remember we are not a commercial graphics studio but just a group of volunteers doing our
best to produce a monthly magazine which displays your photographs at their best and is the envy
of other railway societies. We know this from letters received by the Managing Editor and from our
printers when they are both approached by other railway societies.

Brief Overview of Process:-
Upon receipt in the roimages@rcts.org.uk mailbox the images are extracted a few days before
the monthly deadline into a folder and the associated captions are copied and pasted into a Word
document for all  the pictures received. This document is  the means by which the images and
captions are related and subsequently a caption is placed in the RO against the correct image.

The photographs to be used in the RO are selected by the Managing Editor, listed and a draft
magazine prepared for the Image Editors. The selected photographs are then prepared by the Image
Editors for publication using a process defined by our printers. The work will vary widely in complexity
dependent upon the quality of the original images submitted.

Some photographs require minimal processing as their  colour balance and exposure is almost
perfect. However some photographs can be real challenges and require substantial work to prepare
the image for publication. Improvements made normally relate to the colour balance of the picture
and the avoidance of  excessively dark or  bright areas.  All  photographs are then cropped and
resized to suit the published size and printing requirements.

Cameras:-
These days almost all  of  the pictures submitted come from digital  cameras only a very small
number arise from scanned negatives, prints or slides.

Digital cameras have come a long way since their general introduction but it is  necessary  to
ensure  that the  basic  settings  are in  line  with  what is  needed  for  railway photography. In
most  cases the default  settings that  come with  a  new camera are more than adequate.
Occasionally we have advised members that their submitted images have taken on a colour hue
or lost their overall colours and/or brightness. This is usually due to a change of the original
default  settings or a unnoticed change in the white point  value. Resetting the defaults usually
clears the problem. However in some camera models there is embedded software to allow the image
to be automatically manipulated to provide a bright over saturated and high contrast image because
that is what the manufacturer thinks the photographer wants to see. These defaults should be adjusted
by trial and error.
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It is suggested that the settings for Sharpness, Settings, Saturation and, Colour Balance are set
correctly and are occasionally reviewed and reset if necessary.

The other parameter which affects the picture quality is the ISO (speed) setting used. In general
the lower  the ISO value  the better  the  qua l i ty  o f  the  photograph.  Recent  developments in
digital cameras have improved the quality of the images produced by high ISO values and some
photographs at ISO 3200 are perfectly acceptable, but Noise, the equivalent to Grain in high speed
film days, can be very noticeable on pictures taken at ISO 800 or even 400. Such noise can be
reduced during our image processing but is difficult to eliminate completely.

The exposure parameters of the image are embedded in the image file and so are available for
inspection. In some cases these can be very unusual e.g. 1/1200 at f8 at ISO1600 used for a
stationary subject resulting in a noisy image whereas reducing the shutter speed to 1/300 would
have led to an ISO rating of 400 and a much better quality picture. Please be aware of the ISO
settings you are using to obtain high quality images. The most likely default camera value will be
no more than 200.

Occasionally we receive images from Phones and Tablets and the quality of cameras on these
devices is increasing and will no doubt continue as the years go by. However at present the general
standard of the resulting images is below that of most digital cameras. Therefore before submitting
an image from a device please review the picture to consider whether it is of sufficient quality.

Digital Images:-
Receiving an image as near as possible to the actual scene recorded is the ideal but the inbuilt
camera manipulation of images now makes this difficult to achieve. However we request that no
manipulation of a produced jpg file is undertaken at all. If you are tempted to ‘improve’ the image
before submission then please avoid any cropping, resizing/resampling and sharpening entirely, as
these seriously affect the processing.

JPG and TIF files should be saved at medium or high quality, usually levels 9 or 10 in Photoshop.
RAW files should be converted and saved at the same levels before submission. Do not use the
file abbreviation JPEG.

The image editors are very experienced at determining if a photograph has been manipulated.
They are also skilled at removing distracting objects in the images, so unless you think you can do
it better then leave it to us!

Software:-
Although it may be tempting to manipulate an image before submission we urge you to desist. If
you think you have to make an adjustment,  if  the image is particularly dark for  instance, then
please restrict this to a minimum. There may be a lot of detail in heavy shadow but unless you are
confident in the use of Levels and /or Curves then it is better to leave it alone rather than lose it.

Although we appreciate that many submitters will be using some version of Adobe Photoshop this
has  now become  an  expensive  proposition  and  loads  your  PC with  a  substantial  amount  of
software  features  that  are  aimed  at  graphic  designers  rather  than  photographers.  None  of  it
necessary for image adjustment. Adobe Lightroom is an alternative option but Photoshop Elements
will adequately handle all that is required. If you do not wish to spend large sums of money a very
good alternative is Serif Affinity Photo 2 but it will only run on a 64bit machine.

If open source software appeals to you the two most popular and highly respected packages are
Gimp and Irfanview both of which will do everything you require. Another alternative we use is
FastStone  Image  Viewer .  This  provides  a  great  way  to  view a complete folder of images, print
sets of thumbnails, make up a slide show. All of these software packages do not modify the colours
or saturation of the original image file automatically. Beware that many of the “Free” software
packages you will find on the web do modify the original image file and we see this in a number of
images we receive from regular submitters where we  have  to  remove  large  doses  of  red,  magenta
and/or  yellow as  well  as  heavy  doses  of saturation.
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Image File Names Updated August 2023
The name of the image file is vital and we ask that you adhere exactly to the requirements set out
below. This  is  essential  to  minimise  the  errors  caused by mis-crediting the  photographer  and
attaching the incorrect caption. We try hard to get these correct but regrettably they still occur.

File names need to contain the following information: -
*Photographer’s name – Start your file name text with your surname in full followed by
a space and your given name initial only.
*Unique  image  number –  this  can  be  from  the  camera  or  whatever  you  use
preferably digits only excluding rambling prefixes such as some cameras generate (eg 3Y8A
or 0R6A) IMG however can be left in place.
The name of the TOC - abbreviation if known.
Unit/loco number
*Location
*Date

Fields marked with an asterisk thus* must be present or the image will not be considered for
publication and please ensure each field group is separated by a space.

Eg - Partlow K - 9157 GBRF 66745 Brundall 27 July 2023.jpg

File names should be limited to a maximum of 60 characters as any more may not be visible and
can cause problems with certain software. The file name should not contain the text describing the
photo, this is for the caption not the file name. Also the use of full stops, commas, forward and
back slashes, and @ signs within a filename should be avoided as again this approach causes
software problems. File names set up as the above example do not have to be edited by us. To help
you there are examples at the top of page 4.

Captions
Captions are the most time consuming part of the process and this is the area where we need your
help. There are two problems, one is the identification of the caption with the image and the other is
the level of information provided. On the one hand we receive the minimum of information, as little
as one line of text, to captions with 10 or 12 lines of text. A glance through the RO will show that
most picture captions run to no more than 4 lines of text although in some cases it is no more than
one line. In this day and age we believe there is no reason why sufficient information cannot be
supplied. There are numerous news groups and websites from which you can gather information to
detail a caption starting with realtimetrains.co.uk. The first section of the caption should be the
precise filename as used for the submitted image, ideally the filename should be directly copied
into the email text to avoid transcription errors. A hyphen “ – “ with spaces either side should be used
between the file name and the start of the following caption text.

Looking at an example:-

“Partlow K - 9157 GBRf 66745 Brundall 27 July 2023 - GBRf Class 66/7 No.66745 at Brundall on
27 July 2023 working the very first 6P52 12.13 Whitemoor Yard-Lowestoft Reception.The train
comprised of 20 empty IOA box wagons. The train returns as 6H52 19:30 to Whitemoor loaded
with imported ballast from Norway. Up to four trains per week could run with a ship into
Lowestoft docks every 9 days.”

As you can see Keith Partlow provided a good level of caption information together with the original
full and precise filename as a reference located at the beginning of the caption. This provides a
complete link between the image and the caption and even if there was a typo in the filename they
are still  readily related. The date should be written as an ordinary number e.g.  14 September
2023 without the year. The time of the train in the format with a dot separating the hours and minutes
e.g. 10.47.

3



In the examples shown above the image file can be downloaded straight into the image folder and
the caption (starting with the precise filename) can be copied and pasted straight into the master
caption listing without any editing. Editing these is a time consuming operation and it would be greatly
appreciated if this can be avoided by being more careful how captions are written.

Submission of Digital Images:-

Only 10 images per person per month. Ideally images  should  be  emailed  to
roimages@rcts.org .uk as  attachments.  The number  of images attached to each mail will
be limited to the capacity of your e-mail systems. Please note that roimages@rcts.org.uk is
purely a divert “In Box” and no response will be received as a result of your submission. If
you have a question or comments with regard to the submission then email
d.kelso@btinternet.com and it will be responded to asap.

If your ISP provider has limited Bandwidth there is a free alternative is wetransfer.com. DO NOT use
Cloud services. If you prefer to use Memory Cards or Sticks can be used and should be placed in a
plastic bag. Memory cards and sticks will be returned.

Images and Text Material - RO Features:-

The September RO will see the introduction of a new email postbox - rofeatures@rcts.org.uk
to which all material both images and text intended for use as an RO Feature should be
forwarded. Images for the RO depicting current operations only should be sent to
roimages@rcts.org.uk as described in these guidelines.

Apple Computers:-

Currently the majority of image files arrive as email attachments in a Windows environment.
However over the last few years we have received more submissions from Apple users and
these instructions have now been revised to reflect upgrades in the Apple software.

In iPhoto and Photos, ensure a title box appears below your image :-

In iPhoto, in the View menu at the top of the screen, select Titles.

In Photos, in the View menu, select Metadata and then select Titles.

Fill in the title box with a file name as detailed on page 3.

Open the thumbnail then from the File menu at the top of the screen, select Export. In the window
that opens, ensure that you select Use Title from the File Name drop down box. Click on EXPORT.
The image can now be found, with the title you have added, under Pictures in Finder. To email do
not use APPLE MAIL. Use Gmail or any other web based email and attach your image.
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Non-digital images:-

It is very rare now for us to receive prints except for articles and features of historic interest. If you
are submitting prints then they should be a minimum of 6”x4” (15x10cm) and should be on glossy
paper. Wet process and professionally produced prints are acceptable. Colour prints from negative
film produced by “fast process” high street stores are unlikely to be of sufficient quality. Please
do not attempt to scan old prints. Send to the Image Editor using the Royal Mail Signed
For Service. Advise by email the package contents and the Tracking Number. The items
will be returned the same way. We can accept B+W, and colour negatives and positive colour
transparencies of all film sizes. Please do not send old glass plate negatives without first consulting
the Image Editors.

Send all material to Image Editor at 6 The Fairways, Convent Road, Broadstairs, Kent CT10 3EF.
Negatives and transparencies should be placed in film envelopes, not in paper envelopes, and be
individually labelled. Prints should be labelled on the back with the full caption details. Do not write
directly on the back of the print. Film material, will be returned but prints will not be returned unless
specifically requested and sufficient postage in stamps is included.

Thank you for taking the time to read this Guide and we hope you find the contents useful. If you
have any questions or suggestions then please email d.kelso@btinternet.com

This document can also be found on the our website. Open the home page and scroll to
the bottom of the column headed Railway Observer. Then click the blue button
“Submit Your Pictures,” cl ick the option you require and click OK.

Finally:-

A reminder that roimages@rcts.org.uk is purely a “divert” In Box and no response will be
received as a result of your submission. If you have a question or comments with regard to a
submission then email d.kelso@btinternet.com and it will be responded to asap.

Mike Robinson, Managing Editor
David Kelso & Peter Hicks, Joint Image Editors.

Summer 2023.

Imagesforro Version 05-3 Final. Summer 2023
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